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System Reference DataBase (SRDB) &ﬁh eSd

The SRDB mainly collects and maintains the knowledge related to spacecraft
Monitoring and Control (M&C) such as Telemetries (TM) and Telecommands
(TC) for allowing:

On board SW development
System AIT

Dellvery of data for in-flight operatlons
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SRDB: the data model

The System Reference Database of a given ESA project complies with the project
specific Conceptual Data Model (CDM), that depends on the knowledge defined

and exchanged among stakeholders.
The SRDB is the formal and unique data repository where all the Space System
Model (SSM) knowledge should be centralized.

____________
has / is of ___@ belongs to / contains —
[ SystemElement ﬁ}—_“@

has

i

involves
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Data producer / consumer point of view

All stakeholders need to share the SSM knowledge at conceptual level:

all stakeholders concepts need to be mapped to the overall SSM conceptual data
model (CDM)

Objective: achieve the required semantic interoperability at space system level

(meaning effective and correct data exchange)

Data
Producers

Data
Consumers
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Data producer / consumer point of view

From a data producer point of view: timely population of the SRDB, fully integrated
in the SRDB change control and validation processes.

From a data consumer point of view: timely integration and extension of the
SRDB, fully integrated in the SRDB change control and validation processes.

Data integration >

| Data population

Data
Producers

Data
Consumers
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SRDB stakeholders requirements

What do the stakeholders actually need?

An adequate SRDB tool, which fulfills a minimum set of requirements:

v Generation and instantiation of the project-specific
database physical schema

Data management editors (MMI)
Import / export facility

Data consistency checker
Validation status awareness

Impact analysis for non-regression tests
Differences at concept level between two deliveries

N N N N N NN

Generic script syntax and cross-check verification
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The Main Challenge

Timely, efficiently and effectively support:
» The space system development, test and operation

» The space system knowledge sharing and management

in order to:

» Apply the data producer/consumer viewpoint to the complete Space System
Model (SSM)

» Take into account the project specific SRDB data models needed to fulfil the
project stakeholders data requirements

ChAL
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SIB Application

The Space Information Base Application (SIB) has been developed to fulfil the
SRDB Application Requirements

Consistency Checks
7
SRDB
owa [ 2
IMPORT Configuration Item
Impact Analysis
I
e~
- Configuration ltem
Difference Analysis
7
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SIB Deployment

Classic three-tier deployment allowing:
= Seamless remote access
= No client installation (standard Internet browsers)

= Performance isolation and optimization on server tiers

Application
Server tier

Intranet/Internet

T

Browser Oracle
Clients WebLogic
Server
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Server tier

F1
T

Oracle
Database
Server
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The solution
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The challenge:

Timely, efficiently and effectively support

» The space system development, test and operation

» The space system knowledge sharing and management

The solution:

100% model driven Space System Information Base (SIB) application in
compliance with the project specific data model requirements

Configuration
MMI Model J Item (Cl) Model J

b

‘ l ‘ SRDB Physical Relational Model J
—

—-—— . EE.
[—_———_
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SIB: Model Driven Approach

The SIB application generation is performed by using two different model injection
approaches:

» Run-time model awareness, where the application software has a different
behaviour at run-time depending on the input models specification.

» Model driven code generation, meaning that the application code is first
generated by using a code generator and then deployed in the application

server.
Configuration
MMI Model J Item (Cl) ModeIJ
SRDB Physical Relational Model J
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SIB: Run-time model awareness

The SIB application framework component has been developed by using the
runtime model awareness approach in order to fulfil the requirements
concerning the physical model management and instantiation, the validation
rules engine, the difference report generator and the impact analysis engine.

SRDB Physical
Relational Model

2

FRAMEWORK Impact Analysis
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i
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t
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Configuration
Item (Cl) Model

]

Consistency Checks
7

Configuration Item

I 4

Configuration Item
Difference Analysis
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SIB: Model driven code generation

The model driven code generation approach has been used to automatically
generate the SIB MMI product editor

Relational Model

U 1

SRDB Application
Generator

SRDB Physical J

MMI Model J
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SIB: Models overview

» SRDB Physical Relational Model
O Database Schema SRDBthsicalJ MMI Model J Configuration J

Relational Model Item (CI) Model

SIB Application
FRAMEWORK

U Validation Rules Definition

!}

» MMI Model

U Menu Layout

U Configuration Item View

MMI

» Configuration Item Model

U  “Part of” Definition

U Impact Analysis Definition

0 Difference Analysis Definition
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SRDB PHYSICAL RELATIONAL MODEL:
Database Schema

ICD Versions
ICD Versions
Filter By [ver ]| ®
Action v View ~ Format = Iéﬂ-'fg'—n‘.m""?ad"[ || Freeze 4 Detach
| |* ver | suffix |* 1ssue Date |* Description [vR  |vR Package | application
@"” sgeol [sgeo01 [06-7ul-2010 B [Copyof MIBE.S - caf_ncurve 1237 [MIBES_PKG_Check Constr_Utl [S1Bv4_MIz6_S
o ro— e | e o—
wad
| AP ®=  ssEma [ssET2.1 [27vay-2013 B [SSETICD2.1 565 | SSET21_PKG_Check Constr Ut [S1Bwt_SsET2_1
[ REF b= ssmio [ssmin [26-Apr-2016 By [ssMIcD 10 1446 |[SSM1D_PKG_Check Constr_Utl [s1Bva_SSM1_0
®EF 2= conr FrDLD [conr_prD1.0 [26-apr2016 Xy [conF_prD1o a1 | |s1Bv4_conF_PRD1 0 -
I 8] | | | | |
| |
ICD Tables ICD Fields
Action ~ View ~ Format - |®|E| 1]]| Freeze &t Detach Action ~ View ~ Format - |@.|E| [I]]] Freeze & Datach
I | | | | | | |
* Table Name Alias * Field Name * Data Type Max Size Def. Val. * Mandatory 7
caF - -_-___—
cap E CCF_DESCR 2 VARCHARZ N
cca CCF_DESCR2 3 VARCHAR2 54 N
ccF CCF_CTYPE 4 VARCHARZ 8 N
ccs CCF_CRITICAL 5 CHAR 1 N N
COF CCF_PKTID 5 VARCHARZ 8 N
CPC CCF_TYPE 7 NUMBER 3 N
cPs CCF_STYPE 8 NUMEER 3 N
csF CCF_APID 3 NUMEER 5 N
CsP = CCF_NPARS 10 NUMBER 3 N =
| 56 | | 21 | |
| i | |
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SRDB PHYSICAL RELATIONAL MODEL:
Validation Rules Definition

‘Validation Rules

P

Validation Rules Definition PCF_NAME Description | pPCF_NAME should be uppercased.
Filter 8 f @ .
Action v View~ Format - | (8 4 Freeze fgfiDetech | of Wrap Sy [FEREiitE Definition PCF_NAME=UPPER(PCF_NAME)
[ e | | | A
|1cd version | Table Name | constraint 1d < |Constraint Type Ss | severity “
El .
Al MIB6.9.1 PCFREC PCFRE F heck Error Encoding [PCFL.[PCF_NAME=UPPER(PCF_NAME)]
B mes.sea PCF PCF_D1B Error Description | IF PCF_USCON="r"then shall exist at least one CVE entry having &
B3 miss.sa PCF PCF_D1C Editorial CVE_PARMNAM=PCF_NAME.
R miB6.s. PCF PCF_01D Error “
MIB6.9.1 PCF PCF_O1E L —, S " S }
= L l_: N | Definition [nvl{PCF_USCON,'£") = "Y'l implies [exists (select 1 from CVE where
v MIB6.9.1 PCF PCF_02ZA Fielgd Check MIB Warning CVE_PARNAM = PCF_NAME)]
B8 essa PCF PCF_034 B B P
B miBe.o.1 PCF PCF_03B Field Check ; e - : ) ;
Encoding [PCF].[{exists {select 1 from CVE where CVE_PARMAM = PCF_MNAME
MIB6.9.1 PCF PCF_054 Field Check = =
w | = Tiea] OR NOT (nvI{PCF_USCON,'#") = ")]
4] . — Description | PCF_PID shall be unique.
“
validation Rules
Valhidaton Rules Definition PCF_PID
Filter By ® y
Action = View = Format = | [ e | Freeze £ Detach ol Wrap Encoding [PCF].[PCF_PID]
| il | | | | Description | PCF_yALID shall point to a PCF entry having PCF_MAME = s
|1cd version | Table Hame | Constraint 1d . |Constraint Type |class | sevenity ] PCF_VALID.
MIB6.9.1 PCF PCF_07A Field Check MIB Error - &
MIB6.9.1 PCF PCF_08A Record Check MIE Error o
— TIE e « | Definition PCF_VALID-> PCF_NAME
MIB6.9.. =% ) Error rd . - -
MIBE.9.1 B PCF_08C BT TR IB Editorial Description | IF PCF_VALPAR is not null then PCF_VALID is not null.
PIRGRA POF PCF_DSD Editofal Encoding [PCF].IPCF].[PCF_VALID.PCF_NAME] P
MIB6.9.1 PCF PCF_O8E Cross Check MIB Error
MIES.9.1 BCF PCF_D8F Cross Chedk MIE Erfor = a Definition (PCF_WALPAR is not null) implies (PCF_VALID is not null)
MIBG.9.1 PCF PCF_08G Cross Check MIE Error -
MIB6.9.1 PCF PCF_09A Record Check MIB Error § .
NIE 51 o PCF 098 Foreign Key e et i Encoding [PCF]L[(PCF_VALID is not null) OR MOT (PCF_VALPAR is not null}]
I [ I 1,168] [ P
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MMI Model

Menu 1 .
<] type = complexType =
Label  |string '
description | string
ScriptField [
[ type = compleType
Model251B-MMI-Mode l‘ P Menu 1..@1 T Name | String30Typ
M= ampaType T %}” [y tvpe = complesType | %r“ Language string
applicationTitle| string ' Label  |string ) desiption | string
desmription string desmiption | siring : = :
argetFielc ")
[x]type = complaType
Lov O S Name | String30Type
MML L. (oo |Group R e SR AT T T
type = complesType j" h — 7 oy type = compleType T - label  [string i SourceTable L. 3 ) SourceField L
: label string : description |sting 7tyee = complesType \T/"" [ vpe = compleaType
tableName) String20Type Name  |String30Typ ) Name | String20Typ
dzszpton | =g description | sving
Group 1...1.,]_|
[]type = camplaType T -
label string :
Detail 0. s tableName| String30Typi
yezameTye T \Tf" desmiption | sting
Foreignkey [
[]type = complexType
SourceFieldName| String30Typi
TargetFieldName| String20Typi
desmiption sring
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MMI Model: Menu Layout (example)

</Menu>
<Menu Label="Monitoring Data" description="Moniteoring Data"> View ~
7 -
— SIB MIB69 Main Menu
<Group label="Pcf - TM Parameters" tableName="PCF" description=" WV Validation
Exceptions
File Repository

<Detail>

<Group lzbel="Pcfrec - Compound Parameter " tableName= ="Pcfrec - Compound Parameter":>

V' Flat Table MMI
= General

</Group>
</Detail> ¥ Monitoring Data
<Detail> Pcf - TM Parameters

Pcfrec - Compound Parameter
Ocp - Monitoring check data
Cur - Calibration conditional selection

<Group label="Ocf - Monitoring check" tableName="0OCF" description="Ocf - Monitoring check":>

<Detail>
<Group label="Ocp - Monitoring check data" tableName="0OCP" description="Ocp - Monitoring check da

</Group>
</Detail>
b= Interpretation Function
</Group> I> TM packet definitions
</Detail> > Display and report
B> Group
<Detail> e g Dotn

WV Object View MMI
V' Monitoring Data

<Group lzbel="Cur - Calibration conditional selection" tableName="CUR" description="Cur - Calibration conditional selection">

</Group>
</Details Pcf - TM Parameters
&> Interpretation Function
</Group>
</MMI>
<Menu Lazbel="Interpretation Function" description="Interpretation Function":>
S LA
== [~ I+ European Space Agency
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MMI Model: Configuration Item View (example

</Menux
Pof - TH Parameters
Pt B | el
<Menu Lazbel="Monitoring Data" description="Monitoring Data": FltrBy TiFeE =) S 44
1> vou- |8 oo | ceces || (0D
<Group lebel="Pcf - TM Parameters" tableName="PCF" description="Pcf - TM Parameters"> i | 4 i i ! i ! 1]
[pef pame  fpcf_dess fpef pd edart ot pec [pef e ook wideh [pef vald ++ Pef related ++ [Pef categ Pef ptr [Pt
PADIS | RAFS RIOKNE |21 2 1 5 PRAZ S B
. - i [ B - o
<Group label="Pcfrec - Compound Parameter " tableName="PCFREC" description="Pcfrec - Compound Parameter"> 3 ) E
ComrsFroen 2
</ Group> | Referenced By
C#D DF1 MFO LFO COF0 CRO ORO OFD OC1 GRCO GUAD OCFL OCPD PGP0 FCFD FOPRECO PORRECO AF2  PCO FTVD SO V%o
</Detail> * tlob columns
<Detail» 2/ Pefrec - Compound Parameter
__________———'——'__—. = 0cf - Monitoring check
<Group label="Ocf - Monitoring check" tableName="OCF" description="Ocf - Monitoring check">
«Details vew - | oo | ecoe | B[R
<Group label="Ocp - Monitoring check data" tableName="OCP" description="Ocp - Monitoring check data"> I J
e locf rbcock rbodoct imer |oct_codn |
</Group> Lol T
</Detail> L] L | 1 1}
Cohmrgfroan 2
</ Group> = Referenced By
oL
</Detail> ~ 0cp - Monitoring check data
<Detail»
<Group label="Cur - Calibration conditional selection" tableName="CUR" description="Cur - Calibration conditional selection"> |
o s Y | |
</Group> [ T .-I
i
</Detail> CokavsFromn 3
&b  Cur - Calbration conditional sekection
< >
</Group>
</MMI>

<Menu Label="Interpretation Function" description="Interpretation Function">
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Configuration Item Model

PrimaryKeyField 1.0
type = Siring30Type
IsRootTable 1.1
type = boolean
0T HasParentTable 0.1l . [ForeignKey L.oo
4] type = complexType l'|'l %}J % type = complexType
| TableName] String30Type| SourceFieldName| String30Type
TargetFieldame| String30Type
ChangeImpactDefinitior 1.0
PhysicalTableMapping 1.0l @_ (=] type = complexType
2] type = complexType T FieldName | String30Type
| TableName] string30Type | 1 [<] Severity| ChangeImpactTyp:
Critical
Editorial
Minar
ConceptReference 0. /- I ForeignKey 1.0
UserobjectMode P UserObjectType 1 I~ type = complexType T N I~ type = complexType
_ ! = — _ WE]—@ TargetConcepl! String64Type 11 SourceFieldame String30Type
[type = complexType T A =) tywe = complexType T IsContai TargetFieldName] String30T
. Name Stri Type . sContainer anytype argetFiel me| String30Type
Description | String2000Type InnerTableReferenc 0..:?].‘ - I ForeignKey 1.00
IsContainer| anytype [=] type = complexType %}" =] type = complexType
| TargetTable String30Type | - SourceFieldName| String30Type
TargetFieldName| String30Type
Container 0.1l - [ParentRelationShi 1.0
type = complexType I‘|'I RN = type = complexType
=t SourceFieldMame String30Type
TargetFieldName| String30Type
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Configuration Item Model (example)

<UserCbjectIype HName="Alphanumeric Display"

Description="AND"

I <PhvzicalTableMapping TableName="DFPF" > I

{FrimaryKeyFieldbDPE_EUHBE<!PrimaryKeyFieldb
<IzRootTable>true</IsRootTaklex

<ChangeImpactDefinition FieldName="DFF HEAD" Severity="Editorial"/ />
<ChangeImpactDefinition Fieldlame="DFF NUMBE" Severity="Critical"/ />
<ChangeImnpactDefinicion FieldName="DFF TYPE"

Severity="Editorial"/>

</PhysicalTableMapping>
<«Phy=sicalTableMapping TableName="DPC">

<PrimﬂryKeyField>DPC_EUHBE<fPrimﬂryKeyField>
<PrimﬂryKEyFiEld>DPC_ELDN<fPrimﬂryKeyField>
<HasParentTable TableMName="DFF">

<Foreign¥ey SourceFieldName="DFF NUMBE" Ta:getFieldName=“DPQ_HUMBE“fb

< /HasParentTable>

<ConceptReference TargetConcept="Reporting Data">
<Foreign¥ey SourceFieldName="PCF HAME" Ta:getFieldName=“DPQ_HAME“f}

</ConceptReferences>

<ChangeImnpactDefinition
<ChangeInpactDefinition
<ChangeImnpactDefinition
<ChangeInpactDefinition
<ChangeImpactDefinition
<ChangeImpactDefinicion
<ChangeInpactDefinition

FieldWame="DPC_ COMM"
FieldWName="DFC FLDNH"
FieldName="DPC FORM"
FieldName="DPC MODE"
FieldName="DPC NAME"
Fieldfame="DPFC NUMBE" Severityv="Critical"/>

FieldName="DPFC

TEXT"

— 01 b

</PhysicalTableMappings>

</UserfbjectType>

- g =

=

Severity="Critical"/ />
Severity="Minor"/ >
Severity="Minor"/ >
Severity="Critical"/>
Severity="Critical"/ />

Severity="Minor"/ >

= = EH 1

IzContainer="False">

O “Part of” Definition
O Impact Analysis Definition
O Difference Analysis Definition
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Standard features of generated MMI

Logged In application ; STB_SRDB/MYDATASET SIS Designer =

& ]
Niew Menu panel Monitoring parameters - -
7 518 Menu Pcf Transaction commit/ rollback  saye | Cancel ‘
b= validation
L= General NN O Advanced search area Quick search
Match All (7 Any -
7 Flat Table MMI e B Hide advanced search area /
W Telemetry Case Sensitive?
L~ Reporting Data MName Width Inter | Sptype
> Linear Calibration T ’ E :
I> Checking Descr valid Uscon Corr
B- TM Packet/SCOE Message Pid Related Decim Obtid
[> TM packet processing }
- Display and Report Unit Categ Parval Darc
> Group Ptc Matur Subsys | Endian |
% Commanding Data Bf trar | el
> Patket Header (4 Curtx Valpar Simva
[> Telecommand/SCOE command Search Reset
> Command Sequence
[ Command/sequence parameter set Sonil View ~ Format ~ | WMBE, En.Cons, | Dis.Cons. M ffivetach | o wiap Toolbar |
L= verification = - . =
> Commandfseguence Interpretation | | ‘ | ‘ | | | |
L> Command/sequence parameter range check |name Desar pid Unit |ptc |pfe |width |valid |++ |Related |++ [categ
g,b];;?u‘:t';"g‘ bata SR | Acspoas_ PPR_CSSNORMLIM 131,293 B 2 [ [®', ~
Menitoring parameters : pcf RKEF [acsroseH PPR_CSSUMBRAMAX 131,284 5 5 2 Q, ++ Q, =
W Interpretation Function KEF [acspazn_ ADS_CSSBLENDK 131,295 5 2 Q, ++ Q =
Calibration curve : caf a6 q CL
Testual interpretation : tf ® o | ACSP422_ FDIR_CS5CCT 131,296 5 2 ++ R
Polynomial interpretation : mcf RER [acspros_ FDIR_CSSAMSG 135,082 2 1 Q ++ Q =l
Logarithmic calibrations definitions : lof | 9359 ‘ | ‘ | | | |
Interpretation functions : ifl 3
TM Packet characteristics : tpcf
W Display and Report Columns Frozen 2 group: Monitoring parameters: pcf
Alphnumeric display = dpf
Grap“\icd:p\aly: dpff Referenced By / Hyperlinks to referenced records
Scrolling display : spf
Printout proforma display : ppf CDF1 CURD CVED DPCl GPCOD GRPAD OCFO ocro PCED’ PCFO PCFRECD  PCFREC LF1 PPCO PTVD SpCO VPDO
Menitering groups definition : grp »| Clob columns
[» Commanding Data > Ocf
2/ Cur
| Pefrec
Collapse panel widget 4 ¥
i
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Configuration Item View MMI

View~ |

Monitoring parameters

|7 SIBMenu
W Validation
Exceptions
File Repusilary
W Genzral
Vdf - Database Vercion
7 Flat Table MMD
> Telemetry
> Connmanding Dala
W Objects View
7 Reporting Dita
Honizoring parameters : pef
% Diterpretaticn Function
Calilnalion wurve : el
Testual interpratation : bef
Polynamial interpretation : mcf
Legarithmic calibrations definitions : Iof
Trterpretation tuactions: it
TM Packel characLer slis : tpd
I> Display and Repert
Monizoring groups definition : g-p
> Commanding Data

am BN - ] W=

Pcf
Filter 8y [Pefiame ¥ | | #] Advanced Search

Acion~ View v Format~ HPE| Entons. | »EE a‘gnnam | ol wrap

Descr |Fid |unit

|MI_C1 RS E_ER (1,876 [

[Pte [pfe [vadth  valid _ |+# |Related

[Tt I R [

1 [ [

<1

| Columrs Frozen 2

~| Referenced By
CDFD CURD CURD CVED DPC1 ecd  GRPAD  OCF1 ccpl PCFO
*| Clob columns

| Ocf
oct
Action = View = Forma: = | R[El ZncCons | DisCons.
| Y |
L [Mame |++[Mbchck [Nbool [Irter Codin
=

1 I I I

| Columns Frezen 2

| Referenced By

PCFO PCFRECO  PCFRECT PF2 2pCO PTVO

Gerd
x| Ocp
0cp
Adtien » View= Fomat~ | Encons. | Discons. | | [ | [FTFRGREEN i vetach | o wiap
[ BT [ T [ | \
hame +i [P [Tyne vali Hual: Ri-hk <= |Vripar

B e [ e W
| | E—— ] — |

|l > | .
B ) ) [

| Calumns Frozen 1
| cur
Cur

action » view = Fomat~ | P Encom. | DiCos. =E -
| [ 1 [ - |

|Pname |#+[pos  |Richk |+ |valpar _|Select |

Hivetach | ol wrap

Mo rows faund

[ o T T I [

| Columns Frezen 4

Z[ Pcfrec

= = 1111 O —

— IS L]
= == B EE -

secl

I+l
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Flat Table MMI

View ~ pcf
"V SIB Menu - Pd e wCl
7 Validation Fiter By |Pcfame  [=] || Advanced search
Exceptions
e Action v View » Format~ e[ En.Cons. ‘ Dis.Cone. | E SfDetach | ol wirap
¥ e | | | I | | | | | o \
- |Name Descr |Pd Junit e |pfc |width |vaiid |4+ |related |4+ |catea | Natur |curtx
W Flat Table MMI
;T Ia < o AESAI11S ESA_INHIBIT_CH_1 2 1 8 Q ++ Q ++[s = D = AES_TCHI ~
elemetry =
¥ Reporting Data AESATL2S ESA_INHISIT_CH_1 2 1 8 Q ++ Q ++ = D v AES_TCHI
Pef - TM parameter AESAI32S ESA_INHIBIT_CH_3 2 1 8 Q ++ Q ++[s = D = AES_TCHI
Pcfiec - Compound TM param. AESASMIS ESA_SCAN_MODE 2 1 8 Q ++ Q ++ |5 = D v AES_TSCA
7 Linear Calibration AESBI31S ESB_INHIBIT_CH_3 2 1 8 Q, ++ Q, ++ s = D ¥ AES_TCHI
caf - | Calibrati
CE N”'"E”EI:' : ons AESESM 1S ESB_SCAN_MODE 2 1 3 Q, 4 Q 4+ )5 = D = AES_TSCA
ap - Numerical Poin
S L ARAXS20S C5_USABLE 2 1 Q, ++ Q, ++ [N = D =
Txp - Textual Points AAAXS28S ES_CH1_POLES BLT 2 1 Q ++ Q ++ [N = D =
Cur - Calibration conditional selection AMTZAAVT MT2AVCURRENTA MA 5 2 Q, ++ Q, ++ [N = D =
Mef - Polynomial interpretation AMT2BAVL MT2AVCURRENTE MA 5 2 Q ++ Q, ++ N = D ¥
Laf - Logarithmic calibration definition S T — VA . o Q - Q N o 5 =
Ifi - Interpretation language function
7 Checking AMTBAVL MT1AVCURRENTB MA 5 2 Q, ++ Q, ++ [N = D -
Ocf - Manitoring Checks ESDXSPID POT_STEP_TO_DEG DEG 5 1 Q ++ Q ++ [N = D =
Ocp - Checks Definitons CDUPMACS  [PM A PWR STATUS 1 [} Q, ++ Q, ++[5 = D = €DU_T Ot
W TM Packet/SCOE Message COUPMBOS PM B PWR STATUS 1 0 Q ++ Q ++ |5 = D COU_TOf +
Tpcf-Ty
iy \ 14 [ 1 | [ ] [ ] | [
W Identification < m ] r
Pid - TM packets Identification e e 2
Pic - TM packets Identification Criteria
W TM packet processing ~| Referenced By
PIf - Fixed TM packets
eed Hpa CDFO CURD CURO CVED DPCO GPCO  GRPAO  OCFO ocro PCF2 PCFO  PCFRECO PCFRECO  PLFO PPCO PTVO sPCO VPDO
Vipd - Variable TM packets | Clob col
7 Display and Report iz,Clob, cohsnns
Dpf - Alphanumeric display PcfSyn
Dpc - Alphanumeric display data # Use PM B power status acquired by TTR A if TM Encoder A is active and PM B power status acquired by TTR B if TM Encoder B is active
Gpf - Graphic display
Goc - Graphic deplay data VAR _PMBONStatus : = (CDUTMEAS.raw == 1 land CDUPBATS.raw ==1) lor (CDUTMEAS.raw 0land CDUPBBTS.raw ==1);
Spf - Scrolling display return(VAR_PMEONStatus); Cherk Seript
Spe - Sarolling display data 4
Ppf - Printout proforma
Ppc - Printout proforma definition
7 Group o J
4
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Conclusions:
current achievements and next challenge
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Current Achievements

100%0 Model Driven SRDB Application:

» Fulfilled Requirements:

 Import/Export Interface (corresponding
to the SRDB Physical Relational model)

«  Consistency Checks & script verification R:;zi:::y;::elj MMI Model J |t(;°n:‘f(i§;r::$;;| J
 Impacts Analysis & Differences Report

« MMI for Data & Violations Navigation l ‘ l

e Flat MMI SIB Application

«  Configuration Item MMI (based on the FRAMEWORK Consistency Checks

I 4

master-detail pattern)

» Input Models:
« SRDB Physical Relational Model

- MMI Model : -
 Configuration Item Model
» Three-tier Deployment

Configuration Item
Impact Analysis

I

Configuration Item

Difference Analysis
P
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Next challenge

100%0 Model Driven SRDB Application:

» Fulfilled Requirements:

 Import/Export interfaces (based on the
user specific ICD models)

 Consistency Checks & script verification
 Impacts Analysis & Differences Report
«  MMI for Data & Violations Navigation

* Flat MMI

 Configuration Item MMI (enhancements,
e.g. seamless UUID, Overflow areas, ...) i s

> Input Model: wPoR
 Conceptual Data Model

» Three-tier Deployment

- Consistency Checks
7

Configuration Item
‘ Impact Analysis
r

Configuration Item
‘ Difference Analysis
7
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Automatic generation of a complete model driven
system reference database (SRDB) application

Thank you!

... any questions

‘%&P

el FER ]:Cge to'contact us#f you need any further information!

_*_.a

francesco.sgaramella@esa.int
emilia.barbagallo@esa.int

SESP 2017 — ESTEC. 28t March 2017 cosimo.bruno@dottcb-consulting.it
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